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SmartServer End User License Agreement 
This End-User License Agreement (EULA) covers SmartServer and SmartServer Configuration. 
 
IMPORTANT - READ CAREFULLY: This End-User License Agreement (''EULA'') is a legal agreement between 
you (either an individual or a single entity) (“YOU”) and Tiger Software Ltd (“TIGER”) for the TIGER 
software product(s) accompanying this EULA, which include(s) computer software and may include "online" 
or electronic documentation, associated media, and printed materials (''SOFTWARE PRODUCT''). An 
amendment or addendum to this EULA may accompany the SOFTWARE PRODUCT. By installing, copying, or 
otherwise using the SOFTWARE PRODUCT or any UPDATES (as defined below), YOU agree to be bound by 
the terms of this EULA. If YOU do not agree to the terms of this EULA, do not install, copy, or otherwise use 
the SOFTWARE PRODUCT; however, YOU may return the SOFTWARE PRODUCT to your place of purchase 
for a refund. In addition, by installing, copying, or otherwise using any updates or other components of the 
SOFTWARE PRODUCT that YOU receive separately as part of the SOFTWARE PRODUCT (''UPDATES''), YOU 
agree to be bound by any additional license terms that accompany such UPDATES. If YOU do not agree to 
the additional license terms that accompany such UPDATES, YOU may not install, copy, or otherwise use 
such UPDATES. 
 
SOFTWARE PRODUCT LICENSE 
Copyright laws and international copyright treaties, as well as other intellectual property laws and treaties 
protect the SOFTWARE PRODUCT. This EULA does not grant YOU any rights in connection with any 
trademarks or service marks of TIGER. All title and intellectual property rights in and to the SOFTWARE 
PRODUCT (including but not limited to any images, photographs, animations, video, audio, music and text 
incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the 
SOFTWARE PRODUCT, are owned by TIGER. YOU may not copy the printed materials accompanying the 
SOFTWARE PRODUCT. This EULA grants YOU no rights to use such content. TIGER reserves all rights not 
expressly granted under this EULA. 
 
The SOFTWARE PRODUCT is licensed, not sold. The SOFTWARE PRODUCT is licensed to YOU for use on a 
single computer only. The SOFTWARE PRODUCT may not be installed, accessed, displayed, run, shared or 
used concurrently on or from different computers, including a workstation, terminal or other digital 
electronic device. YOU may not make access to THE SOFTWARE PRODUCT available to others in connection 
with a service bureau, application service provider, or similar business. If TIGER has not provided YOU with 
a back-up copy of the SOFTWARE PRODUCT, YOU may make a single back-up copy of the SOFTWARE 
PRODUCT. YOU may use the back-up copy solely for archival purposes. Except as expressly provided in this 
EULA, YOU may not otherwise make copies of the SOFTWARE PRODUCT, including the printed materials 
accompanying the SOFTWARE. Failure to adhere to the above terms invalidates any warranty YOU may 
have and will result in the SOFTWARE PRODUCT no longer working. 
 
THIS SOFTWARE, AND ALL ACCOMPANYING FILES, DATA AND MATERIALS, ARE DISTRIBUTED "AS IS" 
AND WITH NO WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED. THIS INCLUDES ANY WARRANTIES OF 
FITNESS FOR A PARTICULAR PURPOSE. YOU must assume the entire risk of using the program.  THIS 
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THE AGREEMENT. 
 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL TIGER, OR ITS 
PRINCIPALS, OFFICERS, EMPLOYEES, AFFILIATES, CONTRACTORS, SUBSIDIARIES, OR SUPPLIERS, BE 
LIABLE FOR ANY DIRECT, SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES 
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, LOSS OF 
INFORMATION, BUSINESS INTERRUPTION OR ANY OTHER PECUNIARY LOSS) RELATING TO THE USE OF, 
MISUSE OF, OR INABILITY TO USE THE SOFTWARE PRODUCT, OR YOUR RELATIONSHIP WITH TIGER 
EVEN IF TIGER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 
IN ADDITION, IN NO EVENT DOES TIGER AUTHORIZE YOU TO USE THE SOFTWARE PRODUCT IN 
APPLICATIONS OR SYSTEMS WHERE THE SOFTWARE PRODUCT’S FAILURE TO PERFORM CAN 
REASONABLY BE EXPECTED TO RESULT IN SIGNIFICANT ENVIRONMENTAL DAMAGE, PHYSICAL INJURY, 
OR IN LOSS OF LIFE. ANY SUCH USE BY YOU IS ENTIRELY AT YOUR OWN RISK, AND YOU AGREE TO 
HOLD TIGER HARMLESS FROM ANY CLAIMS OR LOSSES RELATING TO SUCH UNAUTHORIZED USE. 
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All rights of any kind in the SOFTWARE PRODUCT, which are not expressly granted in this EULA, are entirely 
and exclusively reserved to and by TIGER. YOU may not rent, lease, lend, modify, translate or create 
derivative works based on the SOFTWARE PRODUCT. YOU may not reverse engineer, decompile, or 
disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly 
permitted by applicable law notwithstanding this limitation. The SOFTWARE PRODUCT is licensed as a single 
product. Its component parts may not be separated for use on more than one computer. 
 
The package for the SOFTWARE PRODUCT may contain multiple versions of this EULA, such as multiple 
media versions (e.g., in the user documentation and in the software). In this case, YOU are only licensed to 
use one (1) copy of the SOFTWARE PRODUCT. 
 
YOU may permanently transfer all of your rights under this EULA only as part of a permanent sale or 
transfer of the SOFTWARE PRODUCT, provided YOU retain no copies, YOU transfer all of the SOFTWARE 
PRODUCT (including all component parts, the media and printed materials, any upgrades and this EULA), 
and the recipient agrees to the terms of this EULA. If the SOFTWARE PRODUCT is an upgrade, any transfer 
must also include all prior versions of the SOFTWARE PRODUCT. In addition, YOU must de-register the 
SOFTWARE PRODUCT with TIGER. 
 
Without prejudice to any other rights, failure to comply with any and all of the terms and conditions of this 
EULA will result in immediate and permanent termination of this EULA. In such event, YOU must 
immediately destroy all copies of the SOFTWARE PRODUCT and all of its component parts. 
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SmartServer Introduction & Requirements 
Introduction 
Congratulations on your purchase of SmartServer, the world’s premier Computer Telephony Integration 
product. SmartServer is the single, integrated, server-side part of the SmartPhone, SmartMonitor, 
SmartOperator, SmartReports, and SmartCampaign products. However, it is also a useful product in its own 
right. This manual will guide you all the way through SmartServer, explaining to you all the information that 
is available at the click of a mouse.  
 
For information on how to install SmartServer, see the section SmartServer Installation Guide. To find out 
how to set up SmartServer for use in your company, refer to the section SmartServer Configuration Guide. 
There is also a document of Frequently Asked Questions available for a quick reference of common queries 
about SmartServer and SmartServer Configuration. All of these documents are available from the Tiger 
Software web site: www.tiger-software.com.  
 
This document is broken up into five main parts: 
• SmartServer Introduction & Requirements: This section contains hardware/software requirements 

for running SmartServer. 
• SmartServer Installation Guide: Explains the correct method of installing SmartServer. 
• Licensing SmartServer: Information on the SmartServer licensing system. 
• SmartServer User Manual: Explains what can be done with SmartServer. 
• SmartServer Configuration: Explains how to set up SmartServer to work with your phone system. 
 
The user manual is broken into two sections: 
• Information: Shows you all the information available from the various tabs of the SmartServer main 

window. 
• Call History: Shows you how you can export various call histories. 
 
The Information section is further broken up into these eight sub-sections, corresponding to the eight tabs 
of the SmartServer main window: 
• System: Hardware settings, general information, basic network information, and command list. 
• Events: Events list. 
• Live: Calls in progress and the status of the extensions being monitored by the system. 
• Cluster: Composite list of the status of all extensions on all clustered SmartServers. 
• Trunks: Trunk usage chart/statistics and the status of the trunks being monitored. 
• Network: SmartPhone clients and the messages sent to SmartPhone clients. 
• External Calls: Statistics on the inbound, outbound, and missed calls of today. 
• Address Books: Status of address books, including hit rate, and list of unknown callers. 
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SmartServer Requirements 
If your platform requires a TAPI server PC with it’s own list of requirements, and that PC will also have 
SmartServer installed on it, the list of requirements that results in a higher spec will take precedence over 
the other. E.g. if the requirements for the TAPI server PC are higher than the requirements for SmartServer, 
the TAPI server requirements will take precedence and are the ones your machine should conform to. 
 

Minimum Requirements 
• IBM-PC or 100% compatible running Windows 98 / NT Workstation 4 SP6a 
• 700MHz Celeron-class processor 
• VGA display 
• 64 MB Memory 
• 100 MB free hard drive space 
• Network adapter bound to a TCP/IP network 
• Mouse 
• Spare serial port (dependant on switch) 
 

Recommended Requirements 
• IBM-PC or 100% compatible running Windows 2000 Professional / Server SP3 or later 
• 1GHz Pentium III class processor or above 
• 800x600 or higher display resolution 
• 128 MB or more memory 
• 500+ MB free hard drive space 
• Network adapter bound to a TCP/IP network 
• Mouse 
• Spare serial port (dependant on switch) 
• CD-ROM drive 
• Microsoft Data Access Components 2.7 or later 
 

SmartServer Test Platforms 
SmartServer has been tested on the platforms listed below. If you cannot see your platform in the list, 
please contact Tiger Software before installation. 
 
Operating Systems 
• Windows 98, 98 SE 
• Windows NT4 SP6a 
• Windows 2000 SP2 / SP3 
 
Network Configurations 
• Client for Microsoft Networks 
• TCP/IP with DHCP addressing scheme 
• TCP/IP with Static IP addressing scheme 
 
Telephone Systems 
• Siemens HiCom / HiPath with CSTA 
• Samsung Compact 2 / DCS / iDCS 
• Inter-Tel Axxess 
• NEC Infrontia 
• Network Alchemy 
• Nortel Business Communications Manager 
• Panasonic KXTD 
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SmartServer Installation Guide 
For optimal performance, Tiger Software recommends installing SmartServer on a dedicated PC that is close 
to the PBX. This PC needs to have a TCP/IP connection to the local network and a spare serial (or COM) 
port. 
NB Some configurations do not require a spare serial port. If you are unsure, contact Tiger Software. 
 
Before you install the SmartServer software, you will typically need to connect the PBX to a spare serial port 
on the PC. Please discuss this with your telephone maintainer.   
 
You also need the TCP/IP network protocol installed. Please see the Windows Help topic on “Networking” to 
find out how to install TCP/IP on your machine. In Windows 2000, if you have a network card installed in 
the machine, TCP/IP should already be installed. 
 
When you are ready to install the software, ensure that no programs are running on the SmartServer 
machine and proceed as directed below. 
 

Installing from a CD-ROM 
Insert the CD-ROM into your CD-ROM drive and installation should begin automatically. If setup does not 
begin click Start, click Run, enter D:\SmartServer 1.40\Setup.exe in the Open box that appears 
(replacing D with the letter of your CD-ROM drive). Click OK and installation will begin. 
 

Installing from an Internet distribution 
Use My Computer or Explorer to browse to the folder where you extracted the SmartServer installation 
files. Double-click on the Setup.exe file. Installation will begin. 

 
The first screen that appears when SmartServer installation begins is the Welcome screen. Click OK.  
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The next screen gives you a chance to change where files are installed. Click the big button with the picture 
on it to continue. 

 
The next two screens are to confirm the names of the Start menu folders that you would like to make 
shortcuts in. Click Continue on both these screens. If you wish to cancel installation, this is your last 
chance to do so before file copying begins. 

 
Finally, the SmartServer files are copied to your computer. 
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When files have been copied and shortcuts created, a message box will appear to inform you that setup 
completed successfully. Click OK and the setup program will end. 

 
Once installation is finished, you should configure SmartServer to work with your PBX. First, load 
SmartServer by clicking on its item in the Start menu. Once SmartServer is running, open the System 
menu and click Configure. The SmartServer Configuration program will load. To find out how to use this 
program, read the SmartServer Configuration Guide section of the SmartServer manual. 
  
If you ever wish to uninstall SmartServer, make sure SmartServer isn’t running, double-click the My 
Computer icon on your desktop, double-click Control Panel, double-click Add/Remove Programs, and 
in the list that appears, highlight SmartServer and click Add/Remove. 
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Licensing SmartServer 
This document explains how to obtain licenses for SmartServer and how to enter them onto your computer. 
 

Free Trial Period 
SmartServer comes with a 30-day / 5-client free trial period so that you can test it and so that you can 
decide how many licenses you need to purchase. During this period you are not required to buy a license, 
however, after this 30-day period has ended, if you wish to keep using SmartServer, you are obliged by law 
to purchase a license. In fact, after the trial period is over, SmartServer will no longer work until you obtain 
a license. Licenses can be obtained from Tiger Software or your local SmartServer dealer (if appropriate). 
 
NB The public telephone networks are not designed to be, nor should in any way be considered to be 
secure or fraud proof. Tiger Software will not be held responsible for any direct or indirect losses incurred by 
you or your company as a consequence of sending your personal information through such a network by 
telephone, fax, or email. 
 

Getting an Authorization Code 
When you contact Tiger Software for a SmartServer license, they will ask for the Hardware Code that can 
be found by clicking Help>Licensing…. This 24-character code uniquely identifies your version of 
SmartServer as well as the computer it is being run on. After giving this code to Tiger Software, you will 
receive a similar 24-character code that tells SmartServer what sort of license you have. This code will only 
work on the copy of SmartServer you got the Hardware Code from, and only on the computer that this copy 
of SmartServer is running on. Enter this code in the Authorization box of the Licensing dialog box and 
click Enter. 
 
The type of license (and possibly the license’s expiry date) will appear in the appropriate boxes on the 
bottom half of the Licensing dialog box. You may have more than one license for SmartServer at one time. 
To view information about other licenses, click the left and right arrow buttons. Click Close to exit this 
dialog box. 

 
Tiger Software may refuse to give out an Authorization Code if they believe the software was not installed 
by a certified SmartPhone Engineer, or if the installer does not have a valid Purchase Order number. 
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SmartServer User Manual 
 

Information 
Using SmartServer, you can gain access to a wealth of information, some of which is also available from 
SmartPhone. However, you may find it easier to use SmartServer to view that information. This section will 
guide you around the eight tabs on the main window of SmartServer explaining to you all the information 
that is contained within them. 
 

System 
The system tab has four areas of information on it: 
• Hardware: Shows the hardware settings in use by SmartServer. 
• General: Shows general system information. 
• Network: Shows basic network information and telephone number lookup speed. 
• Event list: List of events performed by SmartServer since it started. 
 
Hardware 
The type of PBX SmartServer is connected to is shown next to the PBX label. For HiCom, HiPath, and Inter-
Tel connected via a Serial cable, next to the Serial port label is the number of the Com port that the PBX is 
connected to (or TCP/IP). The Settings label displays the baud rate, parity checking, data bits, and stop 
bits settings of the Com port that the PBX is connected to (or the IP address/port number). For TAPI 
connections, the PBX manufacturer and model is shown next to the Make and Type labels. 
 
All of these settings can be changed using SmartServer Configuration (see Part 2 of this manual). 
 
Next to the Connected label will be the word Connected or the word No depending on whether or not 
SmartServer has managed to establish a connection to the PBX (either via a serial cable, TCP/IP, or TAPI 
driver). The text next to the Session label indicates whether SmartServer is active or not. The text next to 
the Monitoring label will be either Yes or No, indicating whether SmartServer is monitoring telephone calls 
or not. If there is a problem with the PBX, these labels will change to reflect this. 
 
General 
This area shows: the current date and time (updated every minute) of the SmartServer computer, the 
length of time SmartServer has been running, and the last error message received by SmartServer (if any). 
 
Network 
IP address is the IP address of the SmartServer computer. 
Network traffic shows the average number of characters per second being sent over the network by 
SmartServer. 
Network peak displays the highest number of characters sent per second since SmartServer was started. 
Peak traffic is usually observed during system start up. 
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No of clients is the number of SmartPhone clients that are connected to this SmartServer, followed by the 
total number of clients that can connect (the total number is the sum of all the different client licences you 
have – e.g. if you have 10 SmartCampaign licences, and 50 SmartPhone licences, the total will be 60). 
Address books is the number of Address Books configured for use by SmartServer in telephone number / 
name resolution. 
Ave lookup speed is the average number of seconds it takes to resolve a contact telephone number 
(based on the last five searches). This should always be below 0.5s. If it is not, SmartPhone users may 
notice a delay between their phone ringing and SmartPhone popping. 
 
Event list 
The grid in the bottom half of the window is used primarily for informational purposes. It logs when events 
and warnings/errors happen. The sorts of events you can expect to see are System restarted, 
Configure, Loaded n extensions, Loaded Address book: <name>, etc. 
 

Events 
The Events tab has on it a list of events that have happened since the system started. Events are the 
things that SmartServer sends to the PBX and the PBX sends to SmartServer. 
 
For instance, if extension number 100 lifted their telephone handset, the PBX would send an event to 
SmartServer telling it that extension 100 has just gone off hook. Then, the event would get a unique ID 
number and be displayed at the top of the list. The Events tab is used so that system administrators can 
see in detail what is happening. 
 

Live 
The Live tab has two grids on it – Calls in progress and Extensions. 
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The Calls in progress grid lists all the current calls SmartServer is monitoring. It displays the call ID, the 
Start time, the Caller number, the Called number, the last known state of the call (e.g. Held, Parked, 
Ringing, Connected) and the other extension numbers currently participating in the call. Double-clicking on 
one of the calls in the Calls in progress grid brings up a window detailing the history of that call, the 
internal representation of the call, and the raw data received from the PBX for the call (as applicable). 
 
The Extensions grid lists all the extensions that are in the directory. It shows their name, their 
department, their state (OFFHOOK, ONHOOK or RINGING), which SmartServer client software the 
extension is using (if any), and the ID numbers of the calls that they are currently participating in. 
 
The Reset button at the bottom of the screen should only be used as directed by Tiger Software support 
personnel. 
 

Cluster 
The Cluster tab will only be visible if you have Clustering enabled on your system (which is normally if you 
have more than one PBX on your site, or if you have two separate sites linked together). 
 
On the Cluster tab is a list of all the extensions that all the other SmartServers are monitoring. The list 
includes the extension’s number, name, department, and state. 
 

Trunks 
The Trunks tab will only be visible if you are connecting to a non-TAPI switch, such as Siemens HiPath or 
Inter-Tel. It has on it a chart, some trunk usage statistics, and a Trunks grid. 
 
The chart is updated every minute, and information about how many trunks were used in that minute is 
shown. The chart shows the minimum and maximum number of trunks that were in use. The maximum 
number is the top of the red line. The minimum number is the bottom of the red line. So if the red line 
starts at 1.0 and ends at 5.0, it means that in the last minute, there was always at least one trunk being 
used, and at one point there were five trunks being used. 
 
The statistics to the right of the chart show the minimum and maximum trunk usage in the last minute and 
hour and for the whole of yesterday. It splits the data up into trunks used for inbound calls and trunks used 
for outbound calls. 
 
The Trunks grid lists all the trunks installed on your system. It also shows the name and state of each 
trunk, and the call ID associated with the trunk.  
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Network 
This tab shows a list of messages being sent to SmartPhone clients and a list of users who are logged in to 
SmartPhone. 
 
The Messages grid shows which extension each message was sent to, the subject of the messages, along 
with the messages themselves. You can use this grid to help you understand how SmartServer 
communicates with SmartPhone. 
 
The Clients grid lists all the computers that are logged in to SmartServer. It shows their IP address, the 
application they are using to log in (e.g. SmartPhone), the extension number they are logged in as, the 
name of the extension number they are logged in as and their status. 
 
On the bottom of the Network tab is a Release button. Highlight one of the clients in the Clients grid and 
click Release to disconnect that user from SmartServer. 
 

 

External Calls 
The External Calls tab has three areas: Incoming calls (today), Outgoing calls (today), and Missed 
calls. 

 
The Incoming calls (today) area shows total answered and missed calls to main numbers, and total 
answered and missed calls to other numbers since midnight. 
 
The Outgoing calls (today) area shows the totals of Local, National, Mobile, and Other calls made since 
midnight. Local calls are identified as calls to the same area code as the one entered in SmartServer 
Configuration, or calls made without an area code. 
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The Missed calls grid lists all of the external inbound calls that ended before they were answered since 
SmartServer was started. The grid shows the date/time of the call, the caller’s number, the called extension 
number, and the duration of the call (how long it rang before the caller hung up). 
 

Address Books 
The Address Books tab has two grids on it. The Address Books grid lists all the address books that 
SmartServer is set up to work with, along with their status (Offline, Updated, Importing, Active, Inactive) 
and their hit rate – the percentage of incoming/outgoing telephone numbers that were found in that 
address book.  
 
The Unknown callers grid lists all the telephone numbers that rang your company, but could not be found 
in any address book. The grid shows the date/time of the call, the telephone number, the originating town, 
the type of call (to/from/missed), and the called/calling extension. 
 
If you have an Imported data source as an Address Book, you may highlight it and click the Resync button. 
This will immediately re-import the data into the Address Book. You may want to do this when you have just 
set up a new Imported Address Book. 
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Call History 
SmartServer keeps a database of all the calls made to and from every extension that it monitors. Using 
SmartPhone, you can view the last 50 of these calls for one extension. As a supervisor, you may want to see 
a list of the calls made to/from every extension, or you may wish to see more than the last 50 calls. Using 
the SmartServer Export Call History command, you can do this. You can also create complex reports 
using SmartReports (sold separately). 
 
To export a call history to a tab-delimited text file, click System, Export Call History. The Export Call 
History window appears. On this window, select which types of calls to export from the Type drop-down 
list. You can select from either All calls, Internal calls, External calls, or Missed calls only. 
 
All calls are external inbound, external outbound, and internal calls; that were either missed or answered. 
Internal calls are just missed and answered internal calls (calls from one extension to another). 
External calls are missed and answered; inbound and outbound; external calls (calls made to/from an 
external number). 
Missed calls only - produces a list of missed (unanswered) calls. 
 
In the From box, enter the date to start the call export from. Enter the date in a recognised date format 
(e.g. 02/12/00 or 1.6.2001) making sure that the day and month are the same way around as your 
Windows Regional Settings. So, if your system is set to use American date format, enter the start date in 
the format mm/dd/yy not dd/mm/yy. 
 
Do a similar thing in the To box, but instead enter the last date to include in the export. So, to export calls 
that happened between the beginning of January and the end of February, you might enter 1/1/2002 in 
the From box and 28/2/2002 in the To box.  
 
Finally, enter the path and name you would like to give the file in the File box and click OK. After a short 
while, the file will have been created and it will be opened in Notepad. If there are a large number of calls, 
it may take several minutes to create/open – depending on the processor speed of the SmartServer 
computer. 

 
To illustrate using Export Call History, lets say that you want to have a list of all the external calls that 
were made/received between Christmas Day 2000 to the end of February 2001. You want the file to be 
saved on your desktop. 
 
You would choose External calls from the Type drop-down list, enter 25/12/00 in the From box and 
28/2/01 in the To box. In the File box, you would enter something like 
C:\Windows\Desktop\external calls.txt. When you click OK, the file is created and opened in 
Windows Notepad. Because the file is tab-delimited, you can import it into your favourite spreadsheet or 
database program such as Microsoft Excel. To do this, close Notepad, load the chosen program (in this case 
Excel), and open the saved file selecting the appropriate options (text format, tab-delimited). 
 
SmartServer purges any calls from its database that are more than 3 months old. However, by downloading 
call data into SmartReports at least once every three months, it is possible to keep a log of (and run reports 
on) all the calls that SmartServer has ever monitored. 
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SmartServer Configuration Guide 
 
This document describes how to use the SmartServer Configuration program (also called SSConfig) to set up 
SmartServer to work with your telephone switch and computer network. You do not need to run 
SmartServer Configuration from the SmartServer computer; it may be run across your local area network. 
However SmartServer must be running whenever you try to use SmartServer Configuration, and if you want 
to set up an ODBC data source to use for an Address Book, you must create it on the SmartServer PC, and 
add the Address Book using SmartServer Configuration on the SmartServer PC. 
 
To use SmartServer Configuration over a network, just install SmartServer Configuration on the machine 
you want to run it on and run it by clicking the Start, Programs, SmartServer, SmartServer 
Configuration program group item. 
 
If you are running SmartServer Configuration on a machine other than the SmartServer computer, you will 
be presented with the Login screen and you must log in before you can do anything in SmartServer 
Configuration. Log in using one of the extension numbers and passwords that are set as an Administrator. If 
no extensions have been entered or set up as Administrator, you must first set an extension as an 
administrator by running SmartServer Configuration from the SmartServer machine. 
 

Running SmartServer Configuration for the first time 
The first time you run SmartServer Configuration, you will need to set it up to work with your switch (PBX). 

 
Click the Site tab. In the Name box, enter the name you wish to use for this site. This is usually your 
company name. 
 
In the Trunk access box, enter the number you dial to get an outside line. If your PBX is an NEC and uses 
non-standard Least Cost Routing codes, please contact Tiger Software and we will advise you how to set up 
the system so that it works correctly with LCR. 
 
Enter the extension number or group number of the operator/reception desk in Operator. 
 
In the Area code box, enter the local area code of the town you are in. This number will be used when 
performing calculations on how many local calls have been made, as well as being automatically inserted in 
front of any local telephone numbers so that the display of numbers is consistent. 
 
In the Type dropdown list, select the PBX type you are connecting to: either Hicom CSTA for any Siemens 
HiCom or HiPath system, Intertel if connecting to an Inter-Tel Axxess, or Tapi if connecting to a PBX using 
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3rd Party TAPI drivers. Select Not used only if you are not connecting to a PBX (for instance because you 
are using 1st Party TAPI only). 
 
If you selected a switch other than Not used or Tapi, you will need to select a port from the Port drop-
down list. This will usually be Com1 or Com2. If you are connecting via TCP/IP instead of via a serial 
connection, select Tcp/Ip. 
 
NB If you need to use a password to connect to the PBX, and the password has been changed from the 
default password, please contact Tiger Software and we will help you to enter the correct password into the 
system. 
 
If you are not sure which Com port to use, start from the top of the list and work your way down it trying 
each port, and reloading SmartServer until you find the one that works. 
 
For Serial connections, enter the Com port settings in the Settings box. Unless you know your system is 
different, you may leave these at their default settings. Your switch maintainer should be able to tell you 
what serial port settings to use. The port settings are described below. 
 
For TCP/IP connections, enter the IP address of the switch in the Ip box, and the port number the switch is 
listening for connections on in the Port box. 
 
SmartServer will now be configured to communicate correctly with your PBX. Continue reading this section 
to find out how to set up Address Books and Extensions etc using SmartServer Configuration. 
 

Com port settings 
The Settings box on the Site tab of SmartServer Configuration is used to tell SmartServer what settings to 
use to communicate through the selected port with the PBX. The settings for Com ports are made up of four 
comma-separated values. 
 
The first value is the baud rate of the Com port (measured in bits per second). Valid values for this setting 
are: 110, 300, 1200, 2400, 9600, 19200, 38400, 56000, and 128000. This must be set the same as your 
switch baud rate or you risk needing to reboot your switch. This is usually 9600 or 19200. 
 
The second value is the parity checking to use. You may choose between using Even (E), Odd (O), None 
(N), Mark (M), or Space (S). Again, this should be the same as your PBX setting. This is usually N. 
 
The third value is the number of data bits to use. This can be 4, 5, 6, 7, or 8. This will normally never 
change. It is usually 8. 
 
The last value is the number of stop bits. This can be 1, 1.5, or 2. This should also never need changing. It 
should be 1. 
 
The settings that you choose here should always match with the settings that your switch is using. If you 
are not sure which settings your switch uses, consult your telephone dealer – although the default 
SmartServer settings will normally be correct. 
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Setting up Extensions and Trunks 
In order for SmartServer to know who is on the phone to whom, you must tell it to monitor all the 
extensions you have on your PBX. 
 
To do this, click the Directory tab and click the Add button. On the Extension Properties window that 
appears, choose what sort of extension you are adding (Trunk or Extension). To find out about adding 
Agents, please see the section below entitled Setting up Agents. 

 
NB On most TAPI switches, there is no need to add trunks, and on the Inter-Tel, you do not need to enter 
all the trunks, just the main trunk group number (if you know it). 
 
Enter the number of the extension or trunk in the Number box and the name of the extension or trunk in 
the Name box.  
 
If you are adding a trunk, no further information is required, although on the Notes tab you can add an 
Administrative note if you wish. This note can be used for any general purpose such as to remind the 
administrator of important information pertaining to the trunk. 
 
If you are adding an extension, you need to enter more information, as described below. 
 
• If you wish, choose a password for this extension (which the user will need to log in to SmartPhone and 

other applications) and enter it in the Password box. Users with elevated privileges, such as 
administrators that can view other extension’s Call Histories should always use a password. 

• In the Department box, enter the department this extension is in. Department names are used to 
organize extensions into loose groups in SmartPhone and SmartOperator etc. 

• In the Assistant box, you may enter the extension number of the extension’s assistant. 
• Enter the extension’s cellular telephone number in the Mobile no box. 
• In the DDI number box, enter the DDI telephone number for the extension without the area code 

(the number that people would dial if they wished to speak to this extension directly, rather than calling 
the company’s main switchboard number). 

• On the Security tab, select the security settings that are appropriate for this extension (used in 
SmartPhone and other applications). Security settings are described below. 

• On the Advanced tab, set any advanced features of this extension as appropriate. Advanced features 
are described below. 

• On the Plugins tab, place a checkmark beside the Plugins you would like this extension to use and 
configure the Plugins by clicking the Edit button. Plugins are described in the document entitled Getting 
More Out Of SmartPhone. 

• On the Buttons tab, configure the buttons to display on the SmartPhone Phone window (for more 
information, see later in this document). 
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• On the Events tab, select any scripts to run when different events are fired (for more information, see 
later in this document). 

• Lastly, on the Notes tab, you can edit the user’s absence text which is used whenever the extension is 
unavailable e.g. out to lunch. You can also create an administrative note for the extension. This note 
could be used to remind administrators where the extension is located, or to store any other trivial 
information. 

 
Click the OK button. The information you entered will disappear, but the Extension Properties window 
will not close. This is so that you can add more extensions without having to click Add each time. When you 
have finished adding all the extensions and trunks, click Cancel. The extension(s) (and trunks) that you 
have added will appear in the list on the Directory tab. 
 
If you ever need to remove any extensions, highlight the ones you wish to remove and click Remove. They 
will be deleted from the Directory list. 
 
If you made a mistake when entering details, or wish to change the details of any extensions, highlight the 
extensions that need changing and click Properties. Any changes you make on the Extension Properties 
screen will affect all of the selected extensions. 
 
For instance, you might highlight many extensions, click Properties, and then change the department 
name to Sales. This will make all the extensions you highlighted have Sales as their department name. 
 
If you are editing the properties of more than one extension at the same time, the title of the Extension 
Properties window will change from Extension Properties: <extension number> to Extension 
Properties: (<n> exts) where <extension number> is the number of the single extension you are 
editing, and <n> is the total number of extensions that are being edited at the same time. 
 
If you wish, check the Auto create box to automatically create new extensions as SmartServer discovers 
them. On some PBXs, SmartServer is able to download a list of extensions along with names direct from the 
telephone system. On TAPI switches you should enable this feature, restart SmartServer, and then edit the 
extensions that have been automatically created by SmartServer so that they have the security settings you 
desire. 
 

Security Settings 
Listed below are the selectable security settings as displayed on the Security tab of SmartServer 
Configuration’s Extension Properties window. Unless otherwise stated, the security features below are set 
to off by default for newly created extensions. 
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Can dial – if ticked, the selected extension(s) are able to make phone calls from SmartPhone and other 
applications. This feature is on by default. 
Can view call log – if ticked, the selected extension(s) are able to view their own Call History screen in 
SmartPhone and SmartOperator. This feature is on by default. 
Can view address book – enables the user(s) to view the Address Book screen in SmartPhone. This 
feature is on by default. 
Can view extension status – this feature enables the selected user(s) to view the Extension Status 
screen in SmartPhone etc. This feature is on by default. 
Can view To do list – tick this to enable user(s) to view the To do list in SmartPhone. 
Allow call pickup – when ticked, the selected extension(s) can directly answer other user’s calls by 
clicking on Pickup from the Extension Status screen. 
Can use features – lets the selected user(s) view the Feature menu in SmartPhone. This menu enables 
users to quickly turn on telephone system features on their handsets, such as Do Not Disturb, without 
needing to remember and enter feature codes. 

 
Can edit own details – turn off to prevent users from editing their name, department, and password. This 
feature is on by default. 
Can configure buttons – when ticked, the selected user(s) can edit the buttons that appear on their 
Phone window in SmartPhone. 
Can edit address book – if ticked, the selected extension(s) are able to edit records in, add records to, 
and remove records from the internal SmartPhone Address Book. 
Show all extensions’ status – enables the selected user(s) to view (on SmartPhone’s Extension Status 
window) the status of all extensions in the company – not just the ones in their department. 
Can view others call logs – when this is ticked, the selected extension(s) can view the Call History 
screens of other extensions. This feature also enables the selected extension(s) to view the Call History 
screens of contacts in your Address Books. 
Can set external callbacks – ticking this enables the user(s) to set External Callbacks on contacts and to 
view the External Callbacks other SmartPhone users have set. 
 

Advanced Settings 
The following settings are available from the Advanced tab of the Extension Properties window. They 
are all off by default for new extensions: 
 
Exclude from extension status – prevents the selected extension(s) from being displayed on Extension 
Status screens. You would typically use this setting on fax, modem, group numbers, and other extensions 
being monitored by SmartServer but that it’s not useful to display the status of. 
Ignore answer messages – extensions that have this setting enabled will not be included when analysing 
missed calls etc for statistical purposes. 
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Used as a main number – this is used so that SmartServer can count the number of calls to main 
numbers in an organisation and display the statistics on SmartServer’s External Calls tab. 
Keep call details private – turn on to keep the selected extension(s) call details private. This means the 
caller/called name and number will not be shown on the Extension Status. This would be ticked for 
extensions that make sensitive, confidential calls. 
Do not monitor – stops SmartServer from monitoring the selected extension(s). 
Administrator – turn this on for users who are allowed to use SmartServer Configuration to configure the 
system. If no extensions are set up in the directory as Administrators, anybody will be able to administer 
SmartServer. 
 

Buttons 
Buttons are used by SmartPhone’s Phone window to enable users to have quick access to certain 
commands, such as viewing the Extension Status window. Each user can have their own set of 0, 4, or 8 
buttons at the bottom of their Phone window. Each user can be given the option of editing their own 
buttons by using the SmartPhone client software, or system administrators can edit user’s buttons by using 
SmartServer Configuration. 

 
To set up an extension’s buttons, double-click the extension in the directory, and then click the Buttons tab 
of the Extension Properties window that appears. Now, select a number of buttons from the drop-down 
list. 
 
Finally, highlight each button in turn from the grid and click Edit to choose what the button should do. 
 
When you click Edit, the Edit Button window will appear. From here, select the sort of button from the 
Type drop-down list, enter a name for the button in the Display box, and then enter any other required 
information before clicking OK to save the button. 
 
Most of the buttons are context-sensitive, that is, they will only be enabled or “click-able” when the user’s 
telephone is in the right state (e.g. you won’t be able to use the Answer button unless your phone is 
ringing). For a current list of buttons that are available, along with their descriptions, please review the 
relevant section in the document: Getting More Out Of SmartPhone. 
 
To save the settings of the buttons, click OK on the Extension Properties window. 
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Events 
In SmartPhone, certain scripts can be set to run when certain things happen. To set up these scripts, use 
the Events tab of the Extension Properties window. 
 
The list of events that you can set scripts to execute on are: 
• Startup – fired just before SmartPhone finishes loading. 
• New Call – fired when a new call is started – either inbound or outbound. 
• Answer Call – fired whenever a call is answered. 
• Call State – fired whenever the call’s state changes (e.g. from held to connected). 
• Delete Call – fired every time a call ends. 
• Hookstate Change – fired every time the local extension’s state changes (e.g. goes off hook, starts 

ringing, or goes on hook). 
• Value Change – fired whenever the value of one of the call attributes changes – custom attributes can 

be assigned to calls using the Set Result button type. 
• Shutdown – this event is fired just before SmartPhone is unloaded. 
 
To change what happens on one of the above events, highlight the event in the grid and click the Edit 
button. Then, from the Edit Event window, select the script that you want executed from the Type drop-
down list. Finally, click OK on the Edit Event window to save the new event. 
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Setting up Agents 
The ability to create Agents in SmartServer Configuration will only be useful if you have 1 or more 
SmartCampaign licenses on your system. Agents are like virtual extensions that can log in to 
SmartCampaign using their own id and password no matter which telephone extension they are situated at. 
 
Adding, removing, and editing agents is done in much the same way as you would extensions and trunks. 
To add an agent, load SmartServer Configuration, go to the Directory tab, and click the Add button. 
 
From the Type dropdown list, select Agent. 
 
Enter an id for the agent in the Number box  (this does not have to be a number, however it cannot be 
more than 6 characters long and it should be unique. Tiger Software recommend using the format 
AG<nn>, where <nn> is a unique integer, which could range from 01 to 99. 
 
Enter the agent’s name in the Name box, their department in the Department box, and optionally a 
password, which they will need when logging onto SmartCampaign in the Password box. 
 
If you wish, you may leave the other boxes blank, or you can enter the information as you did when you 
were adding Extensions. 
 
On the Security tab put a tick next to the features you would like the agent to have access to. The options 
available are the same as for Extensions. 
 
On the Campaigns tab is a list of all the campaigns that have been assigned to the selected agent. Each 
campaign might have the word (Done) next to it, indicating that the campaign has been completed. 
Campaigns will be worked through in the order in which they are assigned to agents. 

 
To assign a new campaign for the agent, click the Add button. A window will appear listing all the 
campaigns that have been added to SmartServer. Highlight one of them and click the OK button to add the 
campaign to the bottom of the list.  
 
To remove a campaign (for instance one that has been completed) highlight it from the list and click 
Remove. 
 
On the Notes tab of the Extension Properties window, you may enter an administrative note for the 
agent. This can be any text and is not important to SmartServer. 
 
When you are finished editing the agent’s properties, click OK. Like when you add extensions, the 
Extension Properties window will not close, it will clear enabling you to add more agents without having 
to click the Add button again. 
 
As with extensions and trunks, to edit the properties of agents, or to remove agents, highlight them and 
click the relevant button – either Properties or Remove. 
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Setting up Address Books 
 
If you already have databases with your customers and contacts in that you want SmartServer to search 
when matching incoming telephone numbers to names, you need to add them to SmartServer 
Configuration. To do this, click the Address Books tab and click Add. The Address Book window will 
open. 

 
On this window, choose the type of database to use from the Type drop-down list.  
 
If you chose ODBC Data source, proceed as below: 
• Next to the Source box click the ellipsis (…) button to choose which database to use (to create a new 

ODBC data source, see the section Specifying a New ODBC Data Source below). 
• From the Table drop-down list, select the table from the selected data source that contains the 

telephone numbers/names. 
• Choose a display name for the address book and enter it in the Name box. 
• Select whether to show the alphabetical index on the SmartPhone Address Book screen from the 

Alpha directory drop-down list. 
• On the Updates tab, choose whether to use the address book live (by selecting Use contacts live) or 

whether to import the contacts at given time intervals (by selecting Import contacts). If you choose 
to use the database live, you can select Use fuzzy matching for telephone numbers to not use 
punctuation like (‘s or spaces while searching from the Address Book screen. If you select to import 
contacts, you have to decide whether to update the address book every day at a certain time (by 
entering a number between 0 and 23 in the Import daily at… box) or whether to update the address 
book every so many hours (by entering a number in the Import every… hours box). 

• On the Contact Fields tab, choose which fields in the selected table correspond to which fields in 
SmartPhone’s Address Book window. You do not need to enter all of this information. However, it is 
recommended you choose a Unique Id field, as well as name and number. If you have custom fields 
that you would like to map, click Add. To remove custom information, click Remove. 

 
If you chose Microsoft Outlook Contacts or Novell GroupWise Address Book, proceed as below: 
• In the Login box, enter the name of the user to log in as (for GroupWise) or the profile to use (for 

Outlook). No password is required. 
• In the Folder box, enter the name of the folder to use, for instance, Contacts 
• In the Name box, enter the name to use for this Address Book. 
• In the Alpha directory drop-down list, choose whether to show the alphabetical index on 

SmartPhone’s Address Book screen or not. 
• On the Updates tab, choose how often to update the address book, either entering a number in the 

Import daily at… box to update it every day at the same time, or by entering a number in the 
Import every… hours box to update the address book every so many hours. 

• On the Contact Fields tab, check the fields you would like to be shown in SmartPhone. You can only 
view a maximum of 13 fields on the Contact Details window. 
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If you chose Lotus Notes Address Book from the Type dropdown list, proceed as below: 
• In the Server box, enter the name of the Lotus Notes or Domino server computer. 
• In the Database box, enter the name of the Lotus Notes database to use. 
• In the Name box, enter the name you wish to give this address book. 
• From the Alpha directory dropdown list, select either (None) to not use the alphabetical index down 

the side of the Address Book window, or select Use surname to use the alphabetical index by 
contact surname, or select Use company name to use the alphabetical index by contact company 
name. 

• On the Updates tab, enter a number either in the Import daily at… or Import every… hours box 
to make the address book update itself every day at a certain time or every so many hours. 

• On the Contact Fields tab, select up to 13 fields that you want to show on the Contact Details 
window. 

 

Specifying a New ODBC Data Source 
If you want to use a database as a SmartServer Address Book that doesn’t have an ODBC connection, you 
will need to create a new ODBC connection to the database. To do this, on the Select Data Source 
window, press the New button. 
 
NB The screen shots and procedures from this section describe adding a new ODBC connection on Windows 
2000. Screens on your operating system may appear slightly different. 

 
You will be asked which kind of source you wish to create: a User data source which is visible only to the 
currently logged on user or a System data source which is available to all user’s of the machine. 
 
Make your choice and press Next. Now you must select what kind of data source you will be accessing. 
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If you are unsure, look at the extension of the file you wish to access and see if it matches any of the file 
suffixes shown on the Create New Data Source window (such as .mdb, .dbf, .xls, etc). When you have 
made your choice, press Next. You are shown a confirmation window to check that you have selected the 
correct driver.  

 
Press the Finish button now to move on to the final stage. Here you will be shown a set up screen for your 
chosen driver. The layout of this window will vary greatly from driver to driver. Shown below is an example 
for a Microsoft Access database. 

 
To finish setting up this Microsoft Access data source you must give it a name (and optionally a description) 
and select the database file. Enter a name in the field Data Source Name. If you wish, enter a description 
of the database in the Description window. Then, to select a database press the Select button (located 
underneath the word Database). 
 
Locate your chosen file using the dialog box that appears and press OK. 
 
NB For Microsoft Access data sources, there may be a bug in version 2.1 and above of the Microsoft Data 
Access Components which causes extensive network activity. You must ensure that Page Timeout is set to 
5000 and not 5 milliseconds. For more information, see Microsoft Knowledge Base article Q246560 
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Then, back at the ODBC Microsoft Access Setup window press OK and you will return to the original 
Select Data Source window. Select the new data source you have created and press OK to add this data 
source as a SmartServer Address Book.   

 
When you have finished entering all the information, click OK. You may add more address books by going 
through the above process again, remove address books by highlighting them and clicking Remove and 
edit address book options by highlighting the address book and clicking Properties. 
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Campaigns 
If you have purchased a SmartCampaign licence, the Campaigns tab will be visible in SmartServer 
Configuration. This tab enables you to create, edit, and remove campaigns for use in SmartCampaign. Once 
you have created a campaign, you can assign it to agents. For more information on agents, see the section 
above - headed Setting up Agents. 
 
To create a campaign, you first need to make sure you have a number of things: 

• A script of words that agents will say to callers. A script may contain many levels of dialogue, normally 
starting with a short introduction and question by the agent. 

• A fixed set of results. A call should always end with a known result, such as “call back later,” 
“appointment booked,” “not interested,” etc. 

• A number of HTML files containing the words that agents will say. (Tiger Software can create these 
for you if needed.) 

• Lists of telephone numbers of the people you wish to dial. 
 
For further information and help with designing scripts for a campaign, contact Tiger Software. 

 
To create a new campaign, click the Add button. The Campaign window will appear. Make sure you are on 
the General tab, and fill in the information described below… 
 
Next to the Source box, there is a button with an ellipsis on it. Click this button to select the database that 
contains the telephone numbers for this new campaign. The database must be in Microsoft Access format. 
Tiger Software can help you get telephone numbers into a Microsoft Access database from sources such as 
UK-Info Disk or other computerized telephone directories. 
 
Once you have selected the database, select the table or query where the required telephone numbers can 
be found by selecting it from the Table/query dropdown list. 
 
In the Campaign name box, enter a display name for the campaign. This value defaults to the same name 
as the table or query selected in the Table/query list. 
 
From the Id dropdown list, select the field that contains the unique identifier for records in the selected 
table or query. This field should be uniquely indexed. From the Telephone dropdown list, select the field 
from the selected table or query that contains the telephone number to be dialled. This field should be 
unique in each record. From the Name dropdown list, select the field that contains the name of the person 
being called. The Name field does not need to be unique. 
 
In the No answer timeout box, you may enter the maximum number of seconds that SmartCampaign 
should wait for a call to be answered before giving up and dialling another number. If you leave this field 
blank, SmartCampaign will not hang up an unanswered call until the user tells it to. 
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Setting up Scripts for a Campaign 
On the Scripts tab is a “tree” showing the scripts and options that have been set up for the campaign. 
Every campaign starts with one Initial script in the tree. 

 
To select the HTML file that contains the text to be spoken for each script, highlight the script in the tree 
and click Properties. Enter the path to the HTML file in the HTML file box. As you type, a preview of the 
HTML file will be displayed in the HTML Preview area. 
 
Each script will normally have a number of outcomes that will lead to another script being read. To add 
choices to the end of a parent script, highlight the parent script and click Add. Then select a display name 
for the choice and enter it in the Caption box. Select a color for the choice, either Blue, Green, Red, or 
Yellow from the Color dropdown list, enter a unique name for this choice in the Tag box, and select the 
HTML file that contains the words to be read by the agent when this choice is chosen by typing the file 
name in the HTML file box. 
 
It is possible to add any number of levels of scripts. For instance, after the Initial script, the choices might 
be Interested and Not Interested. If the agent selects Interested and reads the Interested script, there 
might be a number of choices at the end of that script such as Product A, Product B, Product C. Then 
those scripts might have options at the end of them, and so on. Whenever you add a script by clicking the 
Add button, the script will be added as a child of the highlighted script, and it will appear in SmartCampaign 
as a choice for agents to click on at the bottom of the highlighted script. 
 
To remove a script, highlight it and click the Remove button. You cannot remove the Initial script. To edit 
the properties of a script, such as the HTML file to be used, highlight the script and click Properties (or just 
double-click the script in the tree). 
 

Call Results 
The last thing you need to do when setting up a campaign is to enter into SmartServer Configuration all the 
possible results that you want to be able to record for each call. When the agent clicks one of the call result 
buttons, a final HTML file is displayed, and the result of the call is saved in the database. 
 
To add results, go to the Results tab and click the Add button. Enter a display name for the result in the 
Caption box. 
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Select a type from the Type dropdown list. The four main types are: 
Keep – keeps the record in the database so it can be called again at a later date 
Not interested – the person was not interested. 
Postpone – call the person again after a specified period. 
Remove – the record needs to be removed from the database (perhaps because the person was abusive). 

 
If you select Postpone from the Type list, you must enter a period of time after which the person will be 
called back. Enter a number in the box next to Delay, and choose a period from Minutes, Hours, or 
Days. For example to call a person back after 2 hours because an answer machine answered the call, enter 
a 2 in the Delay box and select Hours from the dropdown list. 
 
Give the call result button a color – Blue, Green, Red, or Yellow – by selecting the appropriate color from 
the Color dropdown list. 
 
Select the HTML file that should be displayed if this result is chosen and enter the path to the file in the 
HTML file box. A preview of the file will appear in the HTML Preview area. 
 
When you have set all the options for your new result, click the OK button, or click Cancel if you changed 
your mind and do not want to add/edit the result. 
 
Once you have finished creating your campaign, click the OK button on the Campaign window. You may 
now assign the campaign to agents on the Directory tab to make them work your new campaign. 
 

Duplicating Campaigns 
Usually, Tiger Software will help you design your first campaigns and set them up for you. Later on, you 
may want to make another campaign that is only slightly different to the existing ones (for example you 
might want to phone people from another post code or country). 
 
Rather than having to create a new campaign and set up all the scripts and results again, you can copy a 
campaign that already exists and just make the relevant changes. To do this, on the Campaigns tab of 
SmartServer Configuration, highlight the campaign you wish to base the new campaign on, and click the 
Duplicate button. The Campaign window will appear as if you are editing the campaign you highlighted. 
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All you need to do is change the Campaign name from <New campaign> to the name of the new 
campaign, and make the relevant changes to the other fields, for example change the Table/query or the 
Source. 

 
When you click OK, the Campaign window will close, and the configuration of the new campaign will be 
saved ready to be assigned to agents. 
 
To remove a campaign that you no longer need, highlight it and click Remove. 
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Telephone System Features 
SmartPhone has the ability to remember the feature codes for your telephone system, such as the code to 
put your telephone into Do Not Disturb mode, or the Forward All Calls code. If you enter the feature codes 
for your phone system into SmartServer Configuration, SmartPhone users will be able to access the 
Feature menu. From this menu, users can use the features of their telephone by simply clicking on the 
menu, rather than having to remember the codes they would normally dial. 
 

To enter your phone system’s feature codes into SmartServer Configuration, go to the Features tab and 
click on whichever items in the list you wish to add the feature codes for. 
 
You can add codes for the following telephone system features: 
Call waiting on/off – The beeping that lets you know that you have a call waiting 
Door open – To activate the magnetic door release mechanism 
DND on/off – The Do Not Disturb mode that makes an extension unavailable when people ring it 
Forward all calls/Forward cancel – Forwards all incoming calls to a different telephone 
Group pickup – Answers a call that is ringing on somebody else’s phone 
Hunt group join/leave – Make extension join or leave a specific ringing group 
Message On/Off – The light or broken dial tone that indicates a message has been left 
Night answer on/off – When in Night Mode, incoming calls usually ring a special extension 
Page – Talk to another extension or group directly without first ringing them 
Reset all services – Restore telephone system defaults 
Set advisory message/off – The “Out Of Office” message that is shown on the caller’s display phone 
Silent monitor – Listen in on a telephone conversation that another extension is involved in 
Suppress caller id on/off – Stops people you call from receiving CLI from your telephone 
 
You can also enter information about your voice mail system into SmartServer Configuration. From the 
Type dropdown list, select the type of voice mail your company uses. Select (None) if you do not have a 
voice mail. Select VoiceManager if you use Tiger Software’s Voice Manager NT. Select Phonexus if your 
voice mail is a Phonexus system. Select Generic External Voice Mail if your voice mail is some other PC-
based system. Select Internal Voice Mail if your voice mail system is built into the PBX. 
 
In the VM access box, enter the number users dial when they wish to access their voice messages. In the 
VM destination box, enter the number users dial when they wish to leave a message for someone (for 
example if the receptionist wants to put a caller through to someone’s voice mail). 
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Automated Call Routing 
If you have obtained a Call Routing licence from Tiger Software, the Routing tab will be visible in 
SmartServer Configuration. This tab enables you to build rules that will automatically route calls to another 
destination. For example, you may wish to route calls from persons in a certain Address Book to a certain 
department. 

 
To build a rule, click the Add button. The Routing Condition dialog appears. 
In the Name box, you must enter a name to give to this rule. The name should be unique. 
 
In the Caller tel box, enter a search string to try to match incoming numbers CLI to. You may include the 
* wildcard at the beginning or end of the string. For example, to route all calls from area code 01844, you 
might enter 01844* in the Caller tel box. 
 
In the Called tel box, enter a string to match called telephone numbers to. You may include the * wildcard 
at the beginning or end of the string. For example, if your company has DDI numbers in the range 
0207867200 to 0207867399, and you wanted to route any caller that initially rang a number in the range 
0207867300 to 0207867399, you could enter 02078683* in the Called tel box. 
 
In the Ringing ext box, enter the extension that needs to be actually ringing when you want the rule to 
activate. You may include wildcards in the string. For example, to route calls that ring 5100, enter 5100 in 
the Ringing ext box. This box is different from the Called tel box in that the telephone that is ringing 
might not correspond to the number that was dialled – the telephone of the number that was dialled might 
have call forwarding on, or might be unavailable because it is unplugged, so that another telephone is 
ringing. 
 
You may also select an Address Book from the Address book dropdown list. Use this so that if the contact 
that is calling your company is found in the selected Address Book, the rule will route the call elsewhere. For 
example, if you have an Address Books for Trade Customers and Public Customers, you may want to route 
Trade to one department, and Public to another. Select the blank list item (the first one) to route callers 
from all Address Books. 
 
Finally, in the Destination box, you need to enter the new number that calls should be routed to. You can 
route calls to an external number by entering your trunk access code before the destination number. So to 
route calls to voice mail, enter the voice mail number in here. Or to route calls to the operator, you might 
enter 0 in this box. 
 
Once you have finished creating your rule, click OK and it will be added to the list. If you wish to modify a 
previously created rule, highlight it and click the Properties button. To remove a rule, click the Remove 
button after highlighting the rule you no longer want. 
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If you have added more than 1 rule, the Move up and Move down buttons become visible. These buttons 
enable you to specify an order in which rules are processed. SmartServer will process the rules in the order 
in which they are listed on the Routing tab of SmartServer Configuration, so you should use the Move up 
and Move down buttons to select an order of priority for your rules. Once a call has been routed by one 
rule, any other rules will not affect it. 

 
 
In the Caller tel, Called tel, and Ringing ext boxes on the Routing Condition window, you may enter 
multiple numbers separated by commas. So for instance to route calls from the 01480 area code and the 
01595 area code, you would enter 01480*,01595* in the Caller tel box. 
 
An asterisk can be used to represent zero or more unspecified characters at the beginning or end of the 
string. For instance, 144* would match 144, 1447, 144595, etc and *200 would match all numbers that 
end in 200, including 200. 
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Network Settings 
From the Network tab of the SmartServer Configuration application, it is possible to make SmartServer do 
things like send warning messages and reports to administrators, and send updated software to clients 
automatically. 
 

 

Sending Warnings 
To automatically send fatal warning messages (such as messages that the PBX is not working correctly, or 
database error messages) to administrators, enter a comma-delimited list of the extension numbers of the 
administrators that you would like the messages to go to in the Send fatal warnings to textbox. 
 
To automatically send non-fatal warnings to extensions (such as backups not working correctly), enter the 
extensions you want to send the messages to in comma-delimited format into the Send non fatal 
warnings to textbox. 
 
To send daily reports to supervisors, enter the extension numbers of the supervisors that you wish to send 
reports to in the Send daily reports to box. 
 

Automatically distributing SmartPhone updates to clients 
SmartServer enables new versions of client software to be automatically sent to all SmartPhone users. To 
configure this feature, follow the steps below: 
 
There are 3 prerequisites to enabling automatic SmartPhone distribution: 
 
9 The SmartPhone client software has been installed on the SmartServer machine. 
9 The SmartServer machine has a shared folder or drive that all SmartPhone users have read access 

to over the network. 
9 You have obtained a different version of the SmartPhone client to the version your users are 

presently running and have obtained it from an authorised source. 
 
If your system meets the above requirements, you may proceed with configuring your system to 
automatically distribute the updated SmartPhone software. Please remember that the same End User 
License Agreement that you submitted to when first obtaining the SmartPhone software binds all updates 
you obtain or use. 
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The following steps are performed on the SmartServer machine: 
1. Unload the SmartPhone client (if it is loaded) 
2. Copy the new SmartPhone.exe file to the directory SmartPhone was originally installed to 

(usually C:\Program Files\SmartPhone\) 
3. Load SmartPhone (from the Start Menu/Programs/SmartPhone group) 
4. Make sure the updated SmartPhone.exe is copied to the share described above 
5. Start the SmartServer Configuration utility (from the Start Menu or from SmartServer by selecting 

Configure on the System menu) 
6. On the Network tab, tick Send SmartPhone updates 
7. In Source Path, enter the UNC path name of the shared folder/drive where the updated 

SmartPhone.exe can be found. This path is in the format \\machinename\sharename 
8. Click OK to exit SmartServer Configuration 

 
When the above steps are complete, the next time users start SmartPhone they will be informed that an 
update is available, and the new version will be downloaded from the SmartServer machine and installed for 
them. 
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Using Plugins 
Plugins are small code libraries written and produced by Tiger Software that make it possible for 
SmartPhone to integrate fully with different desktop applications such as Sage or Goldmine etc. 
 
Using Scripts, SmartPhone only has limited control over the applications. However, utilising Plugins, 
SmartPhone can more comprehensively control these applications than could be done using Scripts. To use 
a Plugin, first you need to obtain it from Tiger Software. An up-to-date list of Plugin-enabled applications is 
available from Tiger Software or your dealer. 
 
When Tiger Software issue you with a Plugin file, they may also give you an Authorization Code which 
needs entering into the SmartServer in order for the Plugin to be work. See the Licensing SmartServer 
section for further details. 
 
Once you have got your Plugin file and saved it onto the SmartServer computer somewhere, go to the 
Addins tab of SmartServer Configuration, and press the top Add button (in the Plugins area of the tab). 
Browse to where you previously saved the Plugin (usually the SmartServer program directory), highlight it, 
and click Open. This will add the Plugin to the list of available Plugins. 

 
To view the details of a Plugin, select it from the list and click About. To remove the Plugin, click Remove. 
 
To enable a client to use the new Plugin, you will need to highlight the extension from the list on the 
Directory tab and click Properties, then go to the Plugins tab of the Extension Properties window and 
place a checkmark in the box next to the Plugin you want the user to be able to use. You might also want to 
configure the Plugin for your user by highlighting it and clicking the Edit button. Configuration options differ 
from Plugin to Plugin but are mostly just a case of selecting a file, table, and fields. For more help on 
configuring a particular Plugin, please contact Tiger Software. 
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Scripts 
Scripts are used by SmartPhone to make things happen when certain events occur at user’s extensions. For 
instance, you could have a script that searches a custom database application for a caller’s telephone 
number and, if found, displays that record on the SmartPhone users desktop. 
 
Normally, you would get Tiger Software to write any custom scripts you need, however, if you want, you 
can write the script yourself using the VBScript programming language. 
 
To add a script to SmartServer, click the Add button on the Scripts tab of SmartServer Configuration. A 
new window will appear. In this window, enter a descriptive name for the script in the Main function box. 
Then, in the large Script text box, either key in the code directly, or copy and paste it from another source.  
 
The code must always begin with Sub <name> where <name> is the same name as the one in the 
Main function box. And the code must end with End Sub. 
 
When you are finished, click OK. The script will be saved and when SmartPhone users log back in to 
SmartServer, they will be able to use the script. 
 
To view or edit a script, highlight it in the list and click Properties. 
 
To delete a script, highlight it and click the Remove button. 
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Part 1: General 

How do I restart SmartServer? 
Close SmartServer and then load it back up again by clicking Start, pointing to Programs, pointing to 
SmartServer, and selecting the SmartServer item. 
 

How do I know how many SmartPhone clients are connected to SmartServer? 
On the System tab, in the Network information box there is a No of clients label. The number is the 
number of clients currently connected to SmartServer along with the total number of licenses you have. 
Also, on the Network tab all the clients are listed along with their IP address or machine name, extension 
number, name, status, and which client they are using e.g. SmartPhone or SmartOperator. 
 

Can I tell how long it is taking to resolve telephone numbers? 
Yes. On the System tab, look in the Network information box. There is an Ave lookup speed label. This 
label displays the average time in seconds of the last five telephone number resolutions. 
 

Where can I see a list of current calls? 
On the Live tab, in the Calls in progress grid you can see the call ID, the start time of the call, the caller 
telephone number, the called telephone number, the last known state of the call and all the participants 
involved in the call (useful for conference call information). 
 

Can I view the status of all the extensions on the telephone network? 
Yes. On the same tab as above (the Live tab) there is an Extensions grid. This grid lists all the extensions 
you set up in SmartServer Configuration and shows their number, name, department, state, and calls they 
are currently involved in. 
 

Can I monitor trunk usage to see if I need more trunks? 
Yes. Look on the Trunks tab. On the chart (updated every minute) is the maximum and minimum number 
of trunks used in that minute. In the box next to the chart, there is also trunk usage information for the last 
hour and last day. If the maximum number of trunk lines being used is often the same as the number of 
trunk lines you have installed, you may wish to consider buying more trunk lines from your telephone 
dealer. The Trunks tab is only visible if you have entered trunks into SmartServer Configuration, and may 
not be accurate on all TAPI switches. Please check with Tiger Software. 
 

How do I know who is using SmartPhone? 
You can tell which extensions are logged on to SmartPhone by going to the Network tab and looking at the 
Clients grid. This grid shows all the SmartPhone clients currently logged in along with the extension 
number, name, and application of each client. Alternatively, the Clients grid also shows the IP address of 
clients. You can use this to determine which computer people are logging onto SmartPhone and 
SmartOperator with. 
 

Is there a list of missed calls I can view? 
There is a list of missed external calls available on the External Calls tab of SmartServer. The list shows 
the date/time of each call, each caller’s telephone number, each extension called, and the duration of each 
call (how long it rang for). 
 
The missed calls list for a particular extension can be seen using SmartPhone’s Call History screen, or by 
creating a report with SmartReports. 
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Is there a list of unknown callers I can view? 
The unknown callers list for all monitored extensions is displayed on the Address Books tab of 
SmartServer. This list shows the date/time of each call, as well as the telephone number, town, type, and 
extension number of the calls. 
 

Can I view statistics about calls, like average calls per day etc.? 
There are a number of options available to you. You can view trunk usage statistics - as described above - 
on the Trunks tab. You can view total calls and total durations of calls for different types of call like 
inbound calls; missed calls; and outbound local, national, mobile, and other calls by looking on the External 
Calls tab of SmartServer. 
 
You can buy the SmartReports package from Tiger Software, which enables you to create historical 
graphical reports and tables of calls and call durations etc. 
 
There is also a SmartMonitor module available, which lets you view data updated live in tables and charts. 
You can choose which extensions to monitor and set alarms if values become to low or high. The sorts of 
data available include active time, call length, keyboard activity etc. This module is ideal for easy call centre 
management. 
 
 

Part 2: Configuration 

How do I configure SmartServer? 
You can load the SmartServer Configuration program by clicking the System/Configure menu item, or by 
clicking Start, Programs, SmartServer, SmartServer Configuration. Configuring SmartServer is 
discussed in the document: SmartServer Configuration Guide, available from the Tiger Software web site: 
www.tiger-software.com.  
 

How can I find out what hardware settings SmartServer is using? 
Either look on the Site tab of SmartServer Configuration, or look in the Hardware box on the System tab 
of the main SmartServer window. 
 

How do I add extensions to the directory? 
Open SmartServer Configuration, go to the Directory tab, and click the Add button. Enter the relevant 
information and click OK. The information will be saved and the Extension Properties window will reset 
enabling you to add more extensions. If you want to add more extensions, do so clicking OK after each 
one. When you are finished, click Cancel and the Extension Properties window will close. After adding 
extensions, you must restart SmartServer before the new extensions will be monitored. Alternatively, you 
can tick the Auto create feature and SmartServer will attempt to download extensions from your PBX, or if 
it can’t, it will learn about new extensions as they make and receive calls. 
 

How do I remove extensions from the directory? 
In SmartServer Configuration, highlight the extensions you would like to remove from the Directory tab 
and click Remove. After removing extensions, SmartServer needs to be restarted in order for the 
extensions to stop being monitored. If possible, restart SmartServer when no SmartPhone clients are logged 
in. 
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If you do not wish to remove an extension from the directory, but no longer wish the extension to be 
monitored, you can select Do not monitor from the Advanced tab of the Extension Properties screen 
on SmartServer Configuration. 
 

How do I change an extension’s privileges? 
In SmartServer Configuration, highlight the extensions that you wish to edit and click Properties. Go to the 
Security tab and check or uncheck the privileges as necessary. When you click OK, the new properties will 
be saved. Any changed privileges made to an extension will take effect the next time the extension logs in 
to SmartPhone. 
 

How do I change an extension’s name / number / department / password? 
You can do this from the SmartPhone Configuration window, or by using Extension Properties from 
SmartServer Configuration. 
 

How do I change the hardware settings SmartServer uses? 
Open SmartServer Configuration, click the Site tab, and change the details in the bottom half of the window 
(Type, Port, Settings). The hardware settings are described in detail in the SmartServer Configuration 
Guide, available from the Tiger Software web site: www.tiger-software.com.  
 

How do I add and remove Address Books? 
To remove Address Books, in SmartServer Configuration, on the Address Books tab, highlight the Address 
Books you want removed and click Remove. When you remove an Address Book, it stops being used in 
SmartServer and SmartPhone immediately. 
 
To add an Address Book, on the same tab of SmartServer Configuration, click Add. Enter the required 
settings on the General tab, choose which fields to display on the Contact Fields tab and click OK. 
Adding Address Books is described in more detail in the SmartServer Configuration Guide, available from the 
Tiger Software web site: www.tiger-software.com. 

How do I change an Address Book’s properties? 
Highlight the required Address Book and click Properties on the Address Books tab of SmartServer 
Configuration. Any changes you make to an Address Book will take effect when you click OK in the 
Address Book window. 
 
 

Part 3: Licenses 

How do I license SmartServer? 
To license SmartServer, you need to decide how many and what sort of clients you would like to be able to 
use with it, and obtain the appropriate license from Tiger Software. You can purchase licenses by emailing 
(sales@tiger-software.com) or telephoning (+44 (0) 1733 866500). Or if you bought SmartServer from your 
telephone dealer, you may purchase additional licenses from them. 
 

How long can I use SmartServer before I need to license it? 
SmartServer will work for a period of thirty days with a maximum of five SmartPhone client connections 
without a license. This is so that you can test SmartServer before obtaining a license. After this period, 
SmartServer will stop working until you get a valid Authorization Code. 
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Where do I get an authorization code for SmartServer? 
You get a unique authorization code for SmartServer when you obtain a license for it from Tiger Software. 
When you buy a license, you will tell Tiger Software what sort of license you would like, and the 24-
character Hardware Code found on the Help/Licensing window of SmartServer. Tiger Software will then 
give you a 24-character authorization code to enter in the Help/Licensing window. 
 
 

Part 4: Troubleshooting 

Why has SmartServer stopped working? 
SmartServer requires certain system information in order to run correctly. SmartServer obtains this 
information when it is first run and checks it every time it starts subsequently. Unfortunately, this 
information is different in every computer. Therefore, changing the computer you run SmartServer on (or 
changing the hardware in the computer) can cause SmartServer to stop working. You should not make 
copies of SmartServer to be run on different computers. Please contact Tiger Software with the displayed 
error message for further assistance. 
 

Why does SmartServer Configuration not load? 
SmartServer Configuration checks SmartServer is loaded before it starts. If SmartServer Configuration is 
loaded before SmartServer, the splash screen will not disappear and SmartServer Configuration will not 
finish loading until SmartServer is loaded, or until you press Cancel (in which case SmartServer 
Configuration will exit). Also check that the computer you are running SmartServer Configuration on has a 
network connection to the SmartServer computer that it is trying to connect to. 
 


